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EndNote

With this release we have negotiated a campus license which grants the right to use the software
by all MBI employees. The costs of the software are borne centrally.

With EndNote it is possible to collect, manage and store information from different types of
literature (lectures, books, theses, etc.) in a database. By using key terms you can build your own
thematically sorted bibliography. Another handy feature is the integration into Microsoft Word
(2003-2010) and OpenOffice / LibreOffice. EndNote is also interesting fiir TeX users, because of the
abitlity to use an export filter for BibTeX. Within the document you can easily use your references
from your EndNote database directly and summarize them to a bibliography. Furthermore
EndNote supports the literature search in scientific online databases, especially ISI Web of Science
where you can directly export your search results into EndNote.

In addition, EndNote is the standard application of the MBI for central data collection (list of
publications, reports of cost and results accounting).

Some new features of EndNote are a new PDF viewer, enabling users to review an attached PDF
and edit a record in one place and the possibility to update references automatically: a new option
that lets EndNote search online for more complete reference detail which can be used to update
the own data. You will find an overview of all new features at http://www.endnote.com/pr-
enx5win.asp.

Installation

Note: an older Version of EndNote (f. e. EndNote X2) will not be overwritten/ updated. After
installation of EndNote X5 you will find the older version in the programs directory.

First extract the file “EndnoteX5-Win.zip“ f. e. directly on your desktop. In the next step navigate to
the extracted directory and open it. You will find the following files: “ENX5Inst.msi”, “License.dat”
and “MBI-ReferenceTypes-X5.xml“ as shown in figure 1. Double-click “ENX5Inst.msi” to start the
installation process. Please note: You may need administrative rights to install software! Please
contact your local administrator if you have problems during installation. You will find the
responsible admin at https://intern/en/edv/structure/local_support.html.

(% | 0. » EndMotex5-Win

sieren - In Bibliothek aufnehmen = Freigeben far - Brennen Meuer Ordner
Mame Anderungsdatum Typ Grafe
ﬁ_%' EM¥5Inst.msi 05.03.2012 17:07 Windows Installer... 66,837 KB
|| License.dat 05.03.2012 17:07 DAT-Datei 1 KB
I & MBI-ReferenceTypes-X5.xml 12.04.201213:39 AML-Dokument 88 KB

Figure 1 | ENX5Inst.msi — run the installer
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http://intern/de/edv/structure/local_support.html

The setup begins; choose “Next” - figure 2.

43 EndNote ¥5.0.1 Setup

ENDNOTE

Advance your Research
and Publish Instantly

B Manage references, PDFs,
figures, tables & more

B Let EndMote locate full
text automatically

B Export directly from your
faverite online sources

B Collaborate with others
using EndMote Web

E THOMSOM REUTERS

Welcome to the EndNote X5.0.1 Installation

[t iz strongly recommended that you exit all Windows programs
befare running thiz zetup program. Click Cancel ba quit the zetup
program and cloze any programs vou have running. Click Mest to
continue the installation.

EndMate #5 stores your file attachments on the desktop and
YWeh. Join milionzs of researchers, students, and libranans whao
depend on EndMote to arganize references and full kext PDFs, az
well az create bibliographies in over 5,000 publishing styles.

Thank. you far choozing EndHote and enjoyl

The Endote Team
Thomzon Reuters

WARMIMG: Thig program iz protected by copyright law and
international treaties.

[Inautharized repraduction or diztribution of thiz pragram, or any
portian of it, may result in zevere civil and criminal penalties, and
will be prozecuted to the maximum extent pozsible under law.

< Back [ M et » J [ Cancel

k.

Figure 2 | EndNoteX5 setup

Accept the License as shown on figure 3 on page 4.
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4 EndNote X5.0.1 Setup

ENDNOTE

Advance your Research
and Publish Instantly

B Manage references, PDFs,
figures, tables & moare

B Let EndMote locate full
text automatically

B Export directly from your
favorite online sources

B Collabarate with others
using EndMete Web

" THOMSOMN REUTERS

EndNote X5.0.1 Volume License Ver...

Thiz copy of EndMote #5.0.7 iz icenzed to:

Licensee: Leibriz-Gemeinzchaft

Senial Number: 5031503643

By clicking the "Accept” button, | have obtained permizzion to
uze thiz copy of EndMote #5.0.1, and | have accepted the
valume license agreement for Leibriz-Gemeinzchaft, izsued by
Thormnson Reuters.

Click. "Cancel" button to quit thiz installation if you hawe not
obtained permizzion to use, or pou do not want to accept the
license agreement for this software.

< Back ][ Accept » J [ Cancel

b

Figure 3 | License

ReadMe > Next (figure 4)

.
13 EndNote X5.0.1 Setup

ENDNOTE

Advance your Research
and Publish Instantly

B Manage references, PDFs,
figures, tables & more

B Let EndMote locate full
text automatically

B Export directly from your
faverite online sources

B Collaborate with others
using EndMote Web

M THOMSON REUTERS

Read Me Information

EndMaote X5 Read Me
Wersion X5 (15.0.7)
Movember 2011
Thomson Reuters

[ ] »

CONTENTS:

[. NEW FEATURES
[Il. RELEASE NOTES
I INSTALLATIONS
V. CONTACT INFORMATION

I. NEWW FEATURES

* Add and transfer file attachments to references in your

EndMote Web account for areater mobility. Uparade or create

< Back ][ M et > ] [ Cancel

[

Figure 4 | ReadMe

Accept the EULA —figure 5 on page 5.
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44 EndNote ¥X5.0.1 Setup

|

ENDNOTE

Advance your Research
and Publish Instantly

B Manage references, PDFs,
figures, tables & more

B Let EndMote locate full
text automatically

B Export directly from your
favorite online sources

B Collaborate with others
using EndMote Web

s
i THOMSOM REUTERS

End User License Agreement

EndMote(R) End User
License Agreement

THE TERMS AND CONDITIONS OF THIS AGREEMENT
SHALL NOT APPLY IF YOU HAVE OBTAINED ACCESS TO
THIS PRODUCT PURSUANT TO A MULTI-USER LICENSE.
UNDER SUCH CIRCUMSTANCES, YOUR USE OF THIS
PRODUCT SHALL BE GOVERMNED SOLELY BY THE
TERMS AND CONDITIONS OF THE MULTI-USER
LICEMSE.

BACKGROUMD. Thamson Reuters (Sciertific) Inc. has
developed a proprietany computer program designated
"EMDMOTE" fthe "Software"). You the “End User™) may use
the Software to create personal bibliographic databases and
to search those databases. By using the Software andorits
accompanying manuals {he “Documentation”™ and together
with the Software. the “Product™. vou aagree with Thomson

@ | accept the license agreement
(71| do not accept the license agreement

< Back ][ M et > ] [ Cancel

Figure 5 | EULA

Choose “Custom” as Installation Type — figure 6

2 EndNote X5.0.1 Setup

Select Installation Type

Typical

E N D N OT E All application features and the Mozt Popular Bibliographic

Advance your Research
and Publish Instantly

B Manage references, PDFs,
figures, tables & more

BN Let EndMote locate full
text automatically

B Export directly from your
fawarite online sources

B Collaborate with others
using EndMote Web

M THOMSON REUTERS

Output ztules, Online Connections, and Impart Filters will be
inztalled. This option iz recommended for the best
performance.

@ Custom

|z& this option to choose specific application features and
arny Bibliographic Output Styles, Online Connectionz, and
[mpart Filkers you want to inztall in addition to the kMost
Fopular filez. Thiz is recommended for advanced EndMote
Lizers.

< Back ][ Mewt > ] [ Cancel

Figure 6 | Installation Type > Custom

In the next step you can define a custom Destination Folder for the program files. The default
folder depends on your OS — in the example we used a Windows 7 64 (figure 7 on page 6).
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4 EndNote ¥5.0.1 Setup ==

Select Destination

The “Wize Installation “wWizard will inztall the files for Enddate
#5 in the following falder.

- & 1oinztall into a different folder, click the Browse button, and
E N D N OT E select anather folder.

Advance your Research
and Publish Instantly

B Manage references, PDFs,
figures, tables & maore

Y'ou can choose not ta install EndMate #5.0.1 by clicking
Cancel to exit the Wize Installation wizard.

Drestination Folder

B Let EndMote locate full .
e C:\Pragram Files [+86]\EndNate %5

B Export directly from your
favorite online sources

W Collaborate with others
using EndMaote Web

=5
3 THOMSOM REUTERS

[ < Back ][ MHext > ] [ Cancel

Figure 7 | Destination folder (recommended setting)

No you have to select the Features to be installed. Choose the “Additional Styles”. You must select
“Export” and “Generic” and we recommend installing “Chemistry”, “Mathematics” and “Science”
(figure 8).

Ll B
8 EndNote X5.0.1 Setup = [ —
Select Features
------- =3 - | Additional Filters -
B Additional Styles
--------- ¥ | Adgriculture
e R H ¥ | Anthropaology b
E N D N OT EJ --------- ¥ | Artz and Hurnanities
--------- ¥ | Behavior Sciences |
Adv:;ci?l:!ﬂetsm:h --------- ¥ | Buzinesz and Economics 5
an uisn instantly . (¢ i =~ Ehemistr_u
B Manage references, PDFs, | &+ i - I ;
i T=RIEal [ore » Eummunlcatluns and Media A
W Let EndMote locatefut | i £ Dentlsw
text automatically | i TTH . E':':'ll:'g-l_"
B Export directly fromyour (1 T £ Education
favorite online sources [ i e ¥ - | Engineenng and Technology
B Collaborate with others | | e =0~ | Export
using EndMote Web | 1 i =~ | Generic -
THOMSOM REUTERS Inztall Direct E xport Helper
[ Diigk Ciost ] [ Rezet ] [ < Back ][ P et > J [ Cancel
.

[
Figure 8 | Features
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Next ... (figure 9).

L B
451 EndNote X5 Setup El_‘ﬂ

Select Default Citation Manager

EndMote #5.0.1 Inztallation \wWizard has detected a wersion of
r Microzoft Word with a citation management feature installed on
— thiz computer. You have choszen to install EndMote's Cite while
@ You'wite. Please check the checkbox below to uze EndMaote
as your default citation manager for Microsoft \ord,
Advance your Research
and Publish Instantly

B Manage references, PDFS,
figures, tables & more

|ze EndMote az my default citation manager

W Let EndNote locate full Click the Back button ta change the selection far this inztallation,
text automatically
W Export directly from your Chck the Mext button to continue the installation.

favaorite anline sources

B Collaborate with others Click. the Cancel button to quit this installation.

using EndMNote Web

“¥ THOMSOM REUTERS

¢ Back ][ Mest > J [ Cancel

(=

Figure 9 | Default

Confirm with “Next” again (figure 10).

4 EndNote X5.0.1 Setup e

Use EndNote on the ]
desktop and Web Ready to Install the Application

W Save retyping references
B Format citations and the
biblisgraphy in seconds Click the Back button to reenter the ingtallation information or

B Format citations in owver click Cancel to exit the wizard.
5,000 publishing styles

W Search and annotate PDFs Before proceeding, make zure you are logged into the local

® Add or transfer PDF/files !'nan:hi_ne with_ a;lministrative rights anu:_l that no other programs,
ta and from EndNote Web including anti-viruz zoftware, are inning.

E N D N OT E Click Mest to begin inztallation.

< Back ][ @'Ne:-:t)] [ Cancel

-. ]

Figure 10 | Ready to install ...
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1 EndNote X5.0.1 Setup | = S |

Use EndNote on the .
desktop and Web Updating System

B Save retpaine safaeansne .

EndMote ¥5.0.1 Setup

B Format
bibliog
B Format
5,000

W Search

° — |

Owerall Progress

Current Operation

Eutracting Library Catalogs Connections...

Figure 11 | Wait ...

Hit “Finish” to complete the installation (figure 12).

-
43 EndNote X3.0.1 Setup =N

Learn about EndNote
www.endnote.com EndNote X5.0.1 has been successfully

installed.
B Facebook/EndMote

Twitter @EndMoteMews
YouTube/EndMataTralning Click. the Finish buthaon to exit thiz inztallation.

B Register or buy your
copy of EndMote today

B View online tutorials and
sign up for a Web class

B Free Technical Support
and user forum

ENDNOTE

i)

S .
Figure 12 | Complete the installation
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Create an own library with ISI Web of Science and EndNote

At f first create an empty database. Start EndNote and choose “File” and “New” as shown in figure
13. You will be asked where to save your database. We recommend storing the database on your
\home-directory.

B ncicre 5

File | Edit References Groups Tools Window Help

Mew...
Open r

Close

Figure 13 | File > New

After saving you will see your empty database — figure 14.

73] EndNote X5 - My
File Edit References Groups Tools Window Help

Fa| My EndMote Library.enl

@] % ® |[wooes 15 0Q00E ¢ &

My Library = B Author Year Title
M All References

@ Unfiled (D)

W Trash (0)

=~ My Groups

= Online Search
© Library of Con...  (0)
O.LISTA (EBSCO) (0)
© PubMed (NLM)  (0)
© Web of Scienc... (0)

mare...
Figure 14 | Empty database

Exit EndNote.
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Now visit apps.isiknowledge.com. Choose the “Web of Science” tab and use the search form —
figure 15.

WERB OF KNOWLEDGE™ ‘ DISCOVERY STARTS HERE

Go to mobile site | Signin | MarkedList(0) | MyEnd?

All Databases Select a Database Web of Science Additional Resources

Search | Author Finder | Cited Reference Search | Advanced Search | Search History
Web of Science 3"

Search

Example: oil spill* mediterranean

| |
Example: O'Brian C* OR OBrian C*
Meed help finding papers by an author? Use Author Finder.

| |

Example: Cancer® OR Journal of Cancer Research and Clinical Oncology
Figure 15 | Search form of “ISI Web of Science”

Figure 16 shows how a result for searching the author “Elsaesser” might look like.

- '|'|i|'r (0} | % (= saveto: | EndNGlE Web EndNot& RefWaorks F

1. Title: Coronary artery fistula with myocardial infarction due to stea
Author(s) Haerle Tobias; Kronberg Kay; Elsaesser Albrecht
Source: CLIMICAL RESEARCH IM CARDIOLOGY YVolume: 101 Issue: 4 P:
Times Cited: 0 (from Web of Science)

Context Sensitive Links |~ Full Text )

2. Title: PG 1553+113: FIVE YEARS OF OBSERVATIONS WITH MAGIC
Author(s) Aleksic J; Alvarez E. A Antonelli L. A et al.
Source: ASTROPHYSICAL JOURKNAL Volume: T48 [ssue 1 Ardicle Mumib
Times Cited: 0 (from Web of Science)

Context Sensitive Links = Full Text | r o viiew abstract ]

3. Title: Ab initio investigation of surface stress response to charging
Author(s) Albina . -M_; Elsaesser C; Weissmueller J.; et al.
Source: PHYSICAL REVIEW B Volume: 85 Issue: 12 Article Mumber: 125
Times Cited: 0 (from Web of Science)

Context Sensitive Links > Full Text ) r o viiew abstract ]

figure 16 | Search results

Choose the literature you want to import into your library by selecting them and hit the “EndNote”
Button. Alternatively select the publication and hit +.| tocreatealist of
publications from different search results.

EndNoteX5 10


apps.isiknowledge.com

By hitting the “Marked List” you will get a mask where you can edit import options by adding or
removing them as shown in figure 17. Hit the “EndNote” button to import your search results into

Endnote.

Marked List (2 records)

<< Exit Marked List

Your marked list contains records from 1 database(s).
You can output summary data for all records using the "total records™ view, or output more product-specific data from each listed datat

2 total records on the Marked List
Output author, title, source, abstract, and times cited for all records in the Marked List.

2 records from Web of Science ¥
Quiput complete data from this product for these records.

Qurtput Records [ = Hide Output Options |

Step 1: Step 2;
@ All records in this list (up to 500) | Select from the fields below:
© ANl records on page
© Records | | to | |
Author(s) / Editor(s) Title
[l Abstract* [C] cited References*
O] Agdresses Times Cited
ISSN /ISBN [C] cited Reference Count
[ ips Number O Language
O Funding Information Accession Number

*Selecting these iterms will increase the processing time.
[Reset]

Figure 17 | Import options

Step 3: [How do | export to bibliographic managemet

% [=] Savefo EndNal® Web

EndNat&

| Save to other Reference Software EI Save

Source

[ Document Tvpe

O Keywords

[C] Source Abbrev:

O] web of Science Category

Conference
O conference
[C] Publisher ir
O Page Cournl
O subject cat

In the next dialogue activate the options as shown in figure 18 — Open with “ResearchSoft Direct
Export Helper” and choose to perform this action always for files of this type.

| = |

Offnen von savedrecs.ciw \ )

@ Offnen mit | ResearchSoft Direct Export Helper (Standard)
() Datei speichern

Ear Dateien dieses Typs immer diese Aktion ausfihren

Optionen kdnnen im Anwendungen-Fenster in den Firefox-Einstellungen
gedndert werden

Sie machten folgende Datei herunterladen:
2| savedrecs.ciw

Vem Typ: 18] Commen Export Format
Von: http://ets.webofknowledge.com

Wie soll Firefox mit dieser Datei verfahren?

o (o]

Figure 18 | Open with “ResearchSoft Direct Helper”

After hitting “OK” EndNote will start and you will find the imported references in your database.

EndNoteX5
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Optional: read-access to the MBIs publication library

Adjusting EndNoteX5 to work with the MBI libraries

If you want to work with the MBIs databases it is recommended (but not necessary) to import the
MBI preferences.

Start EndNote and choose “Edit” and “Preferences”— figure 19.

AR ——

File | Edit | References Groups Tools Window Help
Undo Ctrl+Z

Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Paste With Text Styles

Clear

Select All Ctrl+ &
Copy Formatted Ctrl+K
Change Text... Ctrl+R

Font

Size

Style

Output Styles
Import Filters

Connection Files

. Preferences...

Figure 19 | Edit > Preferences
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In the next step choose “Reference Types” and “Import“ — Figure 20.

e e ==

- Change Case

Reference Types
- Display Fields
. Display Fonts Default Refersnce Type: ’Joumal Article ']
- Duplicates

 EndNote Web
Modify Reference Ty
.. Find Full Text . =

- Folder Locations

.. Formatting Note: Use the Reference Types Table to add, delete, or rename field
Librari namesg or to modify reference types. The table CANNOT be used to

- Lioranes reorder the fields in a Reference Window.

- PDF

M Reference Types Reference Type Table

Changes made to Reference Types are stored in a special

- Sorting Ref TypeTable xaml file. Tao use a new file orto share your file with
- 5pell Check others, use these Import and Export options:
- Temporary Citations
- Term Lists
Export... Import...
. URLs & Links ’ ] ’ ]
Nate: Importing a new Ref Type Table xmil file will overwrite your curent
Reference Type preferences.
[ Endnote Defaults ] [ Revert Panel ] [ OK ] [ Abbrechen Obemehmen

Figure 20 | Reference Types > Import

Now navigate to unzipped installation folder and double-click “MBI-ReferenceTypes-X5.xml“ —
figure 21 and confirm by hitting “Accept” and “OK” — figure 22 on page 14.

'w| )i » EndNoteX5-Win

-
sieren - In Bibliothek aufnehmen = Freigeben far - Brennen Meuer Ordner
Mame : Anderungsdatum Typ Grofe
ﬁ'_:jﬁ EMXSInst.msi 05.03.201217:07 Windows Installer... 66.837 KB
|| License.dat 05.03.2012 17:07 DAT-Datei 1KE
I |Z] MBI-ReferenceTypes-x5.xml 12.04.201213:39 AML-Dokument S8 KE

Figure21 | MBI-Reference-Types-X5.xml

EndNoteX5 13



e =)

- Change Case Reference Types
- Display Fields
- Display Fonts Default Reference Type: [JO'Ll'ﬂEi Adicle v]
- Duplicates
.. EndMote Web i
Modify Reference Types...
- Find Full Text [
.. Folder Locations
. Formatting Mote: Use the Reference Types Table to add, delete, or rename field
Librari names ar to modify reference types. The table CANMOT be used to
- Libranes rearder the fields in a Reference Window.
.. PDF
. Reference Types Reference Type Table
Sorti Chanages made to Reference Types are stored in a special
- aorng Ref TypeTable xml file. To use a new file orto share your file with
- Spell Check others, use these Import and Export options:
- Temporary Citations
-. Term Lists
- URLs & Links [ ] [ ]
Mote: Importing a new Ref Type Table xml file will overwrite your cument
Reference Type preferences.
Endnote Defaults | | Revert Panel OK || Abbrechen | | Ubemehmen

Figure 22 | Accept > OK

You need to have mapped \\group.mbi-berlin.de\group\info\Bibliography as a network drive.
Then navigate to “File” > “Open” = “Open Library” and choose a library from the “endnote”
directory — figure 23 and figure 24 on page 15.

Bl cranoes ——————

IFlIe Edit References Groups Tools Window Help

Mew...

Open [ Open Library... Ctrl+C
Close 1 X:\endnote\mbi-all-X2.enl

Save Ctrl+5 2 Xhendnoteimbi-a-¥2.enl

Save As... 3 My EndMote Library.enl

Save a Cnow...

Figure 23 | Open a MBI Library
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file://group.mbi-berlin.de/group/info/Bibliography

il e 3 b il

' (B B T :
@:i 'i|v| ) v Computer » Bibliography (Mgroup.mbi-berlinde\grouphinfo) (£:) » endnote »

Organisieren - Brennen Meuer Ordner

<% Favoriten Marne ) Anderungsdatum

Bl Desktop H’_ mbi-z-¥2.enl 17.04.2012 07:47

4 Downloads n’_ mbi-z-X2 Copy.enl 27.03.2012 09:39

&l Zuletzt besucht H’_ mbi-c-¥2.enl 18.04.2012 14:39

“'_ mbi-b-X2.enl 18.04.2012 15:01

- Bibliotheken n’_ mbi-a-¥2.enl 19.04.2012 05:01

[ Bilder “’_ mbi-all-¥2.enl 19.04.2012 09:02

Figure 24 | Choose a library

Read-only access: you will always get an error message when you open a MBI database. Just hit
”(_)K" —figure 25.

S e

@ The file "mbi-a-¥2.enl" is locked or is on a locked volume, Mo changes

will be saved.

Figure 25 | Hit “Ok”

An opened MBI library (figure 26):

EndMote X5 - mbi-a-

File Edit References Groups Tools Window Help

mbi-a-X2.enl

(6] % © |[imou 5 0QO0E ¥ [ HIW O~

My Library  ~ B Author Year Title
M All References (4339) N. Zhavoron... 2012 Interaction of femtosecond laser puls
@ Unfiled (4339) M. Zhavoron... 2012 Preparation of heavy glass samples .
il Trash (4) N. Zhavoron... 2012 Generation and characterisation of ul
H HYuH J. 2012 Manifestation of quantum disordered
=My Groups M. J. J. Vrak... 2012 Attosecond-time-resolved molecular
=My Smart Groups M.J.J. Vrak.. 2012  Atomic and molecular physics at FEL
R01.401Bachelorl.. (1) |y U D00 ot of FP7 Marie Gure I
£.02.10-2012 (4) e ;

M. J J Vrmak. . 2012 Member of Joint Research Activity "2

R T MV A Ty Fiall

Figure 26 | Opened mbi-a-X2.enl
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Add-In for Microsoft Word/ OpenOffice

Cite While You Write (also known as CWYW) is a key feature of EndNote. It allows you to access
EndNote from within Microsoft Word to insert citations into your Word documents. You can in-
sert citations anytime during your writing process.

CWYW automatically builds a bibliography from the citations you insert. You can also create a list
of figures.

Figure 27 shows the EndNote integration into Microsoft Word 2010:

Start Einflgen Seitenlayout Verweise Sendungen Uberprifen Ansicht EndMote X5 Acrobat

k. EM Go to EndMote Style:  Annotated - Export to EndMote ~
& _j' Edit & Manage Citation(s) Ef, Update Citations and Bibliography Glgﬁl Preferances
Ci{g;ﬂﬁ - g Edit Library Reference(s) 3 Convert Citations and Bibliography ~ ? EndMote Help
Citations Eibliography (P Tools

Figure 27 | EndNote integration into Office 2010

A video tutorial about CWYW for OpenOffice (Windows).

Users of BibTex can download the necessary export styles here:
ftp://support.isiresearchsoft.com/pub/bibtex/

Further information:

http://endnote.com/support/helpdocs/ENX5 GettingStartedGuide MacWin.pdf - EndNote
Handbook

http://endnote.com/training/tutorials/EndNoteX5/Menu 970x562/EndNoteX5.html - Online
tutorial
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Appendix A - further assistance
If something does not work as expected and you run into trouble, do not hesitate to contact the IT
staff for support at the addresses listed below. Please always try to get help within your division

first, before calling the central hotline.

IT-support in your division:

Division  Local support staff Internal phone E-Mail

Al Rainer Schumann 1222 schumann@mbi-berlin.de
A2 Andreas Hentschel 1247 hentschel@mbi-berlin.de
A3 Frank Noack 1270 noack@mbi-berlin.de

B1 Dirk Rohloff 1312 rohloff@mbi-berlin.de

B2 Rainer Hoffmann 1317 rhoffmann@mbi-berlin.de
B3 Jens Glasel 1312 glaesel@mbi-berlin.de

C1 Helmut Walz 1423 walz@mbi-berlin.de

Cc2 Marina Friedrich 1447 fried@mbi-berlin.de

c3 Gabriele Kordass 1472 kordass@mbi-berlin.de
c3 Klaus Reimann 1476 reimann@mbi-berlin.de

Central Hotline
Office hours: Mo - Fr, 09h - 16h
Phone: +49 30 6392 1555 (1555 internal call)

E-Mail: support@mbi-berlin.de (internal)
external-support@mbi-berlin.de (external)

Office: MBI, Building A (19.29), Room 4.14

Information about the MBI-IT
https://intern.mbi-berlin.de/en/edv/index.html

Do not hesitate to give some feedback on this document to the author(s).
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